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Instead, use Seagull’s Driver Wizard to upgrade existing printer drivers: 
1. Run the Driver Wizard utility from the folder where the driver files are 

located.  (The default location is C:\Seagull) 
2. Select Upgrade Printer Drivers and complete the wizard. 

Removing Printer Drivers 

Driver Wizard may be used to remove printer drivers from the system. 
1. Run the Driver Wizard utility from the folder where the driver files are 

located.  (The default location is C:\Seagull) 
2. Select Remove Printer Drivers and complete the wizard. 

Installing BarTender Web Print Server 

This application is only available with the Enterprise Automation edition. To 
install this option:  
1. If you are not already viewing the opening dialog of the install program, 

place the BarTender CD-ROM into your CD drive. The opening dialog 
will appear automatically.  

2. Click BarTender Label Management Suite. 
3. Click BarTender Web Print Server and follow the instructions. 

Activation 

During the installation, you will have the opportunity to activate your 
software. Activation is a quick, easy, anonymous process that unlocks a 

software product for unlimited use and helps combat software piracy. When you 
choose to activate, an Activation Wizard will run. Click its Help button for 
more information about activation and privacy.  
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Common Procedures for Commander 

Launching Commander 

To launch Commander, double-click its icon on the BarTender branch of the 
Start menu. Below are the steps for the most common tasks.  

Creating or Modifying a Commander Task List 

Commander actions are governed by tasks lists, which identify the triggers 
and the tasks to be performed in response. To create a task list: 

1. Create a new task list file by clicking the new task list button  or 
selecting New from the File menu. If you are modifying an existing task 
list, click the open button  or select Open from the File menu; then 
browse to the task list file and click Open. 

2. Start a new task definition by clicking the create new task toolbar button 
 or selecting Add from the Tasks menu. If you are editing an 

existing task, highlight it and click the properties toolbar button  or 
select Properties from the Task menu.  

3. Use the Task Options dialog to enter details about how to trigger the 
task and to select and configure the commands that will execute when 
the task is triggered, then click OK. 

4. Repeat steps 2 and 3 for every task needed on the task list, and then save 
the task list. 

Deleting, Moving, and Reordering Commander Tasks 

Delete tasks from the list by highlighting the task and pressing the DELETE 
button or selecting Delete from the Edit menu. Use the Cut, Copy, and 
Paste items on the Edit menu to reorder tasks as needed or to move tasks 
from one task list to another. 
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Running a Commander Task List 

To run a Commander task list: 

1. Open a task list by clicking the open button  or selecting Open from 
the File menu. 

2. Enable tasks by highlighting each task you want to execute and 
selecting Enable from the Task menu. 

3. Start trigger detection by clicking the start detection button  or 
selecting Start Detection from the Detection menu. 

For More Information 

There are a number of sources of additional information on Commander.  

Commander Help 

Commander comes with an extensive help system that includes detailed 
examples of Commander in use and additional information about its many 
powerful features. 

White Papers 

These two white papers provide more details about using Commander: 

http://www.seagullscientific.com/ftp/whitepapers/WhitePaper_
Commander.pdf 

http://www.seagullscientific.com/ftp/whitepapers/WhitePaper_
CommanderExamples.pdf 

http://www.seagullscientific.com/ftp/whitepapers/WhitePaper_Commander.pdf�
http://www.seagullscientific.com/ftp/whitepapers/WhitePaper_Commander.pdf�
http://www.seagullscientific.com/ftp/whitepapers/WhitePaper_CommanderExamples.pdf�
http://www.seagullscientific.com/ftp/whitepapers/WhitePaper_CommanderExamples.pdf�
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Appendix A: Serial Communications 

Overview 

We recommend that you use a parallel port, USB port, or Ethernet 
connection if any of these is available on your printer. They improve printer 
performance and they eliminate confusion about what kind of cable to use.  

However, some printers come with only a 9-pin or 25-pin (RS-232) serial 
port. This section covers some of the most common obstacles encountered 
with such old-style serial port communications and explains how to best 
configure Windows and select the proper serial cable. 

Note: 

A more detailed discussion of serial communication issues is in the 
Serial Communications section of your printer driver’s help. 

Setting and Cable Issues 

If you don't set the serial ports on your computer and printer identically, 
communication will be unreliable. Moreover, there are dozens of ways that 
serial cables can be wired internally and one can't tell by looking at a serial 
cable how it is wired. 

It is important to keep in mind that the program from which you will be 
printing, such as BarTender, does not control the serial communication 
between your computer and printer. Your mode of serial communications is 
controlled by: 
♦ The serial port settings in your printer. 
♦ The serial port settings on your computer. 
♦ The type of serial cable being used. 
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Serial Port Settings 

Serial communication is governed by the following parameters. These must 
be set identically on both the printer and the computer. 
♦ Baud Rate: This is the rate at which your printer will receive data (in bits-per-

second). Common values are 2400, 4800, 9600, 19200, 38400, and 57600; 
with 9600 being the most common default setting. You want to set the highest 
rate at which your printer will work reliably. Use trial-and-error to find this 
rate after you have set your other serial communication parameters. 

♦ Data Bits (sometimes called "Word" length or byte length): This specifies 
the number of bits used to encode each character sent to your printer. The 
most common value is 8, although older printers may default to 7.  

♦ Parity Bit: This is an optional extra bit sometimes sent after the data bits 
of a transmitted character for the purpose of error checking. The possible 
settings are Odd, Even, and None. 

♦ Stop Bits: This is the length of the pause at the end of a transmitted 
character. One stop bit is the most common setting. 

♦ Flow Control (sometimes called "Handshaking"): This can be set to 
software (also called Xon/Xoff) or hardware. Never use the None 
setting for Flow Control. Disabling flow control can result in 
intermittently corrupted or completely failed print jobs.  

Note: 

Refer to the topic Understanding and Setting Flow Control 
(Handshaking) in your printer driver's help for more information about 
choosing a handshaking method.  

Setting Serial Parameters on your Printer 

You control serial port settings for your printer with either DIP switch 
settings or through a menu system accessed from the printer's front panel. 
Consult your printer's documentation for details. 
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Most printers do not allow changing all of the above parameters. Consult 
your printer manual to determine what settings are required, and be sure to 
make identical settings in Windows. 

Setting Serial Parameters in Windows 

You first specified your serial port settings when you installed your printer 
driver, but if you need to change them, follow the procedure below to 
configure your serial port. 
1. Click the Windows Start button. 
2. In Windows 2000, 2003 and XP, select Settings and then Printers. In 

Windows Vista, select Control Panel and then Printers.  In Windows 
7, select Start, then Devices and Printers.  The Printers (or Devices 
and Printers) folder will be displayed. 

3. Click your right mouse button on the printer you wish to change your 
settings for and select the Properties option. The Properties dialog opens. 

4. Click on the Ports tab. 
5. To check your port settings, click on the Configure Port button.  The 

Port Settings will be displayed. 
6. Adjust your port settings as necessary and click OK. 
7. Click Close to exit from the printer’s Properties dialog. 

Using the Correct Serial Cable 

Because a printer and computer both use serial ports that have their inputs 
and outputs on the exact same pins, a wiring configuration must be 
established that crosses over the outputs from one port to the corresponding 
inputs of the other port. A serial cable that connects signals by crossing them 
over in this manner is referred to as a null modem cable. By contrast, a 
straight-through serial cable, often used to connect a computer to a modem, 
connects pins 1, 2, 3, etc. on the computer to pins 1, 2, 3, etc. on the modem. 
If a straight-through serial cable were attached to a printer, an output signal 
from the computer would go, not to an input pin of the printer where it can 
be received, but to an output pin of the printer where it would be ignored. 
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Note: 

Some newer thermal printers do require a straight-through cable. If 
there is any doubt, you should consult the documentation provided by 
the manufacturer. 

Cabling and Flow Control (Handshaking) 

It is also possible to cross over other lines so that the printer can offer the 
hardware handshaking option. (Refer to Serial Port Settings above.) Thus, it 
is important to consult your printer's manual to determine what cable is best. 
Some general purpose cable configurations, though they may contain more 
wires than all printers require, will work for a great variety of printers.  

Note: 

Refer to the help for your driver for pin and wiring diagrams of the null 
modem cables most commonly used by thermal printers, and for a 
special note on grounding. 
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Appendix B: Configuring for Performance 

Performance Tips 

Some of the graphics capabilities of Windows, including the ability to print 
TrueType fonts, can result in large amounts of information being sent to your 
thermal printer. Therefore, you should optimally configure your printer and 
personal computer.  

The following tips contain information to help you maximize your printing 
speed and understand the difference between images that are formatted by 
Windows and images that are formatted by your printer. 

Avoid RS-232 Serial Communication Whenever Possible 

Some thermal printers come standard with only a 9-pin or 25-pin (RS-232) 
serial port. A parallel port, USB port, or Ethernet connection may be extra 
options. RS-232 serial communication will work fine if you only intend to 
use your printer's built-in bar codes and typefaces. However, if you want to 
take advantage of any of Windows' graphics capabilities, you will achieve 
significantly better performance if you use a parallel port, a USB port, or an 
Ethernet connection. 

Use Printer-based Objects and Fonts or Downloaded Fonts 
Whenever Possible 

Windows programs often print images, and non-downloadable fonts, by 
drawing them out dot-by-dot using bitmap graphics, a process that can slow 
the printer. Fortunately, many thermal printers can output bar codes, lines, 
boxes, and built-in (or downloaded) scalable text fonts using high-level 
commands. A Windows program can, for example, print using a font built 
into the printer by outputting a few quick control codes, instead of sending a 
large dot-by-dot bitmap drawing of the text image. 
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There are times when a Windows program must output an image as a bitmap. 
So keep in mind, that the more graphics that you send to your printer, the 
slower your printing speed will be. 

Printer Capabilities That Are Not Available To All 
Programs 

Because most of the special capabilities built into thermal printers are 
different for each brand of printer, and because thermal printers are totally 
different from the more common printers used by Windows, it is just not 
possible for standard Windows programs to access certain high-level thermal 
printer commands. BarTender, however, was designed to take advantage of 
these commands.  
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Appendix C: Printer Driver Troubleshooting 

This appendix presents the best procedure for solving printing problems.  

Step-by-Step Procedure for Solving Printing Problems 

If you are having any problems printing, take the following steps. If this does 
not resolve the problem, contact Seagull Technical Support (Refer to 
Appendix D: Technical Support.) 
1. Check Serial Port Settings: If you are using a serial port, check your 

printer and Windows settings for baud rate, data bits, stop bits and 
parity. (Refer to Serial Port Settings in Activation.) 

Do not assume that the “default” printer settings shown in your manual 
reflect your printer’s actual settings. You must directly inspect either the 
mechanical switches (usually on the back of your printer) or the front 
panel menu settings before you can be sure how your printer’s 
communications settings are configured. 

2. Check Cable: Check that the cable is properly connected and attached 
to the correct port on your computer, and that the Windows printer port 
settings accurately reflect the port to which the printer cable is attached. 

3. Print the Printer’s Status Page: To check for mechanical problems 
with the printer, print out from the printer's control panel (not from a 
computer) some document or label that is built into the printer's 
memory. Such documents have different names depending on the 
printer model. They are sometimes called status pages, sample labels, 
configurations, or configuration labels. Consult your printer manual for 
the exact steps. If you are unable to print such a test document or label, 
you may need to have your printer serviced before you can continue 
with the rest of this troubleshooting process.  

Note: 

If you had to adjust a printer switch in order to output your printer’s 
status page, remember to put it back the way it was. 
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4. Reboot Printer: Your printer may not have properly reset after the last failed 
print job or after the last time you made a change to a communication setting. 
Turn the printer off and leave it off for five seconds before turning it on 
again. When it goes on again, make sure it completes its self-test procedure 
before you attempt to print again. (No lights should be blinking. Some 
printers will display the word Ready or display a ready light, usually green.) 

5. Print the Driver’s Test Label: For the first print job after steps 1 
through 4, use the Seagull printer driver's Print Test Label feature: 
a. Click the Windows Start button. 
b. Select Settings and then Printers. The Printers folder will be 

displayed. 
c. Click your right mouse button on the printer you wish to change 

your settings for and select the Properties option. The Properties 
dialog opens. 

d. Click the General tab. 
e. Click the Print Test Page button. 

If no label (not even a blank label) comes out and/or you get a 
printer communications error message, proceed to step 11. 
Otherwise, continue with step 6. 

6. Print Device Text From Application: Create a label in your application. 
Use only the fonts built-into your printer, rather than Windows TrueType. 
If this test works, and you do not need to use any graphics or TrueType on 
your label, then you should be able to implement your desired label design 
right away and get back into production. 

7. Print Small Graphics From Application: Add a very small graphic to 
the label, and one letter of TrueType text (such as Arial or Times New 
Roman). This first letter test should be a small size, around 12 pt. 

If the TrueType text and graphic do not print, you may need to upgrade 
the printer's firmware or memory. Consult your printer manual for more 
information. 

8. Print More Graphics From Application: Increase the point size of 
your TrueType text and try printing an entire word or more in 
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TrueType, instead of just a single letter. If this works, then you should 
go ahead and try to print all of the graphics you need on your label. 

9. Diagnose Printer Memory Shortage: If all of your TrueType or 
bitmap graphics print perfectly only so far down the label and then are 
cut off cleanly straight across the label, you have insufficient memory in 
your printer to output the amount of graphics you are attempting to 
print. Contact your printer reseller for a printer memory upgrade. 

In contrast to the clean cut off described in the previous paragraph, if the 
printer outputs incorrect label data, corrupted graphic images, or even no 
label at all, this too may indicate a memory shortage. But, if you are 
using a serial port, it may also indicate a flow control (handshaking) 
problem, as described in step 10. (Always turn the printer off and on 
again following his type of failure.) 

10. Diagnose Serial Port Flow Control Problems: If you are using a serial 
port and a print job stalls and/or generates a communication error 
message after some data has already been successfully transmitted to the 
printer, you may have a flow control problem. 

Test for this by slowing down your printing speed. For example, if you 
had been printing at 9600 baud, try a test print job at the much slower 
rate of 1200 or even lower. (Make the identical change in the port 
settings for both Windows and your printer.) 

If slowing down the baud rate made your problem go away, or caused the 
problem to occur later in the print job, then you should adjust your flow 
control settings. Try switching from software (Xon/Xoff) to hardware 
flow control (or vice versa). Be sure you are using a cable that will allow 
your printer to use hardware flow control. (Consult the printer's manual.) 

11. Diagnose Serial Port Cable Problems: If the Print Test Label fails 
and you are using a serial port, you can test for a cabling problem by 
temporarily turning off flow control (handshaking).  
a. Verify that your printer’s communication settings agree with those 

in your Windows port settings. 
b. Verify that you are using a “null-modem” cable, rather than a 

“straight-through” serial cable. 
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c. Change the Windows Flow Control settings for your serial port to 
None. Then, turn your printer off for five seconds and back on again.  

d. After your printer has finished its power-on self-test, repeat the 
small print job.  

If the print job is successful, you have confirmed that the cable is 
incompatible with the flow control (handshaking) system. Determine 
what is wrong with your cable. Correct it, and then switch back to either 
software (Xon/Xoff) or hardware flow control. 

12. Diagnose Other Problems: If you still can’t print, it is very likely that: 
♦ You have a second hardware product competing for an interrupt 

or I/O address with your communication port.  

or 
♦ You have an advanced Windows setting configured improperly.  

Either way, you need to contact your computer vendor or your 
company's internal computer support staff for assistance.  

Other possible problems: 
♦ A bad (or improperly configured) serial printer cable. For example, 

a simple “3-wire” null-modem serial cable will not allow printing 
from inside Windows unless your flow control is set to None. 

♦ The printer cable is attached to the wrong port of your computer.  
♦ A malfunctioning printer port in your computer or printer. 
♦ The printer is off or off-line. 
♦ The computer’s communications port may be conflicting with 

some other hardware component in your computer. 

You will have to rule them out one-by-one in order to solve your problem. 
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Appendix D: Technical Support 

If you still have questions after consulting this manual and the help system, 
Seagull’s Technical Support Department can be reached at the phone numbers 
and e-mail addresses below. Faxed technical support requests receive a faxed 
response. Internet technical support inquiries receive an Internet response.  

You Must Register Your Software to Receive Support 

Register your product online at: 

http://www.seagullscientific.com/aspx/registration.aspx  

Unless you register your product, you will not receive technical support. 

You Must Call From Next to Your Computer 

When calling for technical support, it is very important to call from a phone 
right next to a computer that is running BarTender. This makes it much 
easier for our technical support personnel to assist you. 

About Tech Support for Visual Basic Script  

Technical support for Visual Basic Scripting is limited. For information on 
support limitations, please refer to Technical Support, A Note on Technical 
Support for Visual Basic Scripting in BarTender’s help. 

Technical Support Contact Information 

Please see next page. 

http://www.seagullscientific.com/aspx/registration.aspx�
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Seagull Scientific, Inc.  – USA, Canada & Latin America 
Voice Telephone: 1 425 641 1408 
FAX: 1 425 641 1599 
Internet: TechSupport@SeagullScientific.com 

Seagull Scientific Europe, Inc.  – Europe, Middle East & Africa 
Voice Telephone: +34 91 435 55 45 
FAX: +34 91 578 05 06 
Internet: EuroTech@SeagullScientific.com 

Seagull Scientific Asia-Pacific, Inc. 
Voice Telephone: +886 2 3765 2440 
FAX: +886 2 3765 2467 
Internet: AsiaTech@SeagullScientific.com 

Seagull Scientific Asia Pacific: Japan Branch Office 
Voice Telephone: +81 3 5847 5780 
FAX: +81 3 5847 5781 
Internet: JapanTech@SeagullScientific.com 
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